TI Designs
Three-Outlet Smart Power Strip

TI Designs
TI Designs provide the foundation that you need including methodology, testing and design files to quickly evaluate and customize the system. TI Designs help you accelerate your time to market.

Design Resources

- **TIDM-3OUTSMTSTRP** Design Page
- **MSP430i2040** Product Folder
- **ULN2003LV** Product Folder
- **TPD1E10B06** Product Folder
- **TPS77033** Product Folder

ASK Our Analog Experts
WEBENCH® Calculator Tools

Design Features

- Measures Individually Power and Current of Three Socket Outlets
- Built-In Relay for Further Functionality Expansion
  - Switch Off an Output Based on User Current Limit Setting
  - Switch On and Off an Output Based on User-Set Master Current Trigger Level
- Supports Latched and Non-Latched Relay
- Built-In Power Supply and Debugging Interface
- Onboard Connector to External Communication Module Like
  - Isolated Serial (on First Version)
  - Wi-Fi (To Be Added in Later Version)
  - Bluetooth (To Be Added in Later Version)

Featured Applications

- Smart Power Strip
- Home Security
- Home Automation

An IMPORTANT NOTICE at the end of this TI reference design addresses authorized use, intellectual property matters and other important disclaimers and information.
# System Overview

## 1.1 Cautions and Warnings

The EVM is designed to operate by professionals who received appropriate technical training, yet it is designed to operate from AC supply. Read the safety related documents that come with the EVM package and the user guide before operating this EVM.

- **CAUTION**
  Read user guide before use.

- **CAUTION**
  Do not leave the EVM powered when unattended.

- **CAUTION**
  HOT SURFACE: Contact may cause burns. Do not touch.

- **CAUTION**
  HIGH VOLTAGE: Electric shock possible when connecting board to live wire. The board should be handled with care by a professional. For safety, use isolated equipment with overvoltage and overcurrent protection.

## 1.2 System Description

This document discusses an application of a three-socket power strip with power consumption measuring capability using a simple, low-cost Texas Instruments MCU MSP430i2040. The MSP430i2040 is a mixed signal microcontroller that integrates with four differential input 24-bit sigma-delta (SD24) A/D converters (ADC) with a programmable gain amplifier, a 16-bit hardware multiplier, an eUSCI_A0 supporting UART, an SPI communication interface, an eUSCI_B0 supporting SPI, an I2C, two 16-bit timers, and 12 I/O pins in a 28-pin TSSOP or 16 GPIO pins in a 32-pin QFN package. The peripheral set is a good combination for electricity power measurement.

In addition to the hardware for performing voltage and current measurements, this design also includes hardware for relay driving circuits so that additional functionality using the measured parameters can be added to a wider range of end applications. The communication interface is also designed to accommodate modules of wired or wireless communication.

In this document, all the description of the setup, operations, features, behaviors, functions, and interfacing is based on the default firmware and the original hardware design. Proper functionality is not guaranteed if changes are made to the hardware and firmware.
2 Design Features

2.1 Basic Operations

This design uses all four SD24 ADCs on the MCU: three are for the current of each socket, and one measures voltage. The ADCs run at approximately a 1.024-MHz modulator frequency fixed by the hardware. The sample frequency derives from the modulator frequency divided by 256 equals 4 kHz, which gives a Nyquist bandwidth of 2 kHz. This bandwidth sufficiently covers the 31st harmonic for 60 Hz AC and 40th harmonic for 50 Hz AC frequency.

Figure 1 shows the system functional diagram. The four SD24 ADCs take samples from one voltage and three current channels with the (calibrated and programmed) fractional delay. The samples then pass through a DC removal filter. Each DC removal filter dynamically tracks the DC offset of the ADC (and the signal) by analyzing each sample and removing any DC before passing the sample to AC processing.

The three current samples and the voltage sample then performs a square and accumulates to get the root mean square current ($I_{\text{rms}}$) and voltage ($V_{\text{rms}}$). The three current samples also multiply and accumulate with the voltage sample with proper additional phase delay (if needed) to get the active power ($P_{\text{active}}$) and with the corresponding 90 degree-shifted sample to get the reactive power ($P_{\text{reactive}}$).

After eight AC cycles, the system sets a flag to show results that need to process. Triggered by this flag, the system then performs the scaling and converts those accumulated values into values of proper units ($V$, $A$, $W$, and so on).

![System Functional Diagram](image-url)
2.2 Board Overview

![Board Overview Diagram]

Figure 2. Board Overview
3 Block Diagram

3.1 Circuit Design and Component Selection

Figure 3 is the block diagram of the system. The design of this smart power strip can be divided into several sub-systems: the power supply sub-system, the communication sub-system, the relay sub-system, and the sensor sub-system. This design guide discusses the sensor sub-system.

3.2 Interface Circuit

The key factor of a successful and accurate metering circuit design very much depends on a good sampling circuit. The four SD24 ADCs on the MSP430i2040, together with the on-chip programmable gain amplifier, provide the critical hardware for getting high-quality AD conversion results from both current and voltage sensors. Moreover, the interface circuit, the component selection, and the circuit layout also play a crucial role for a successful design.

Due to the nature of a SD24 ADC and of the voltage and current signals being measured, an external interface circuit is needed to interface the voltage and current to keep the SD24 ADC to work properly and provide proper filtering for the band of interest.

The hardware of the interface circuit is simple, which is composed of passive components apart from the protection diode. Figure 4 shows the interface circuit designed. The top three circuits are exactly the same for the three current sensors. The shunt resistors and the bottom circuit is the interface to the voltage sensor.

In the current sensor interface circuit with R6 (A, B, C) being the shunt sensor, D1 (A, B, C) is the optional protection diode. The protection diode is not required unless, for example, a high shunt resistor value or a current transformer is in use instead of the current sensor and the user anticipates a significant current surge to send enough voltage across the sensor high to damage the MCU.
L1 (A, B, C), R9 (A, B, C), and C9 (A, B, C) forms a low pass filter having a bandwidth of a few MHz. The purpose of this filter is to reject radio frequency interference from going into the SD24 ADC. The filter formed by L2 (A, B, C), R8 (A, B, C), and C8 (A, B, C) has the same characteristic, which is balanced for the differential signal. The filter formed by R9 (A, B, C), R8 (A, B, C), and C10 (A, B, C) is a filter that gives a bandwidth of about 10 kHz, which is the filter for the band of interest.

The order of magnitude of these capacitors should be observed although the actual value of the capacitance is not that critical.

The voltage sensor interface is a resistor ladder. The ratio of the resistance in the resistor ladder allows up to 308-V AC and 420-V DC to be measured. The current sensor filter is similar except that the value of R10 is 100 Ω, not 1 kΩ. The reason for this is the voltage divider circuit has an equivalent source

\[
\text{resistance } = \frac{1.5k \times 990k}{1.5k + 990k} = 1.5k
\]

in series with R10. To balance the filter for the differential signal, the sensor uses a small R10 value. The combined effect is of similar value to R11. Although there is a slight mismatch using the designed value, this effect has no observable impact to accuracy.

The voltage and current sensor interface circuit is shown in Figure 4.

### Figure 4. Voltage and Current Sensor Interface Circuit

#### 3.3 Component Considerations

##### 3.3.1 Shunt Resistor

For accurate measurements, the choice of shunt is another important factor. In practice, a shunt of smaller value (<1 mΩ) is a better choice than a larger value (>2 mΩ). A smaller shunt value benefits the power dissipated on the shunt and the respective rise in temperature. The lower rise in temperature reduces the need for a very low temperature coefficient shunt resistor to sustain the accuracy. However, small value shunts also have drawbacks. The signal-to-noise ratio (SNR) of a small value shunt is worse than using a larger value one. In this sense, there may be chance that a shunt of higher value is desired, such as when measuring a very small current and the range of the current to be measured is also small. Therefore, a design needs to consider a few factors: the maximum current, the current dynamic range, the heat generated on the shunt, and the ventilation of that heat.

In this application, the maximum current for each socket is 16 A, and the desired dynamic range of current keeping flat error percentage is 1000:1 (16 A : 16 mA). The power dissipated on the shunt resistor should be as small as possible.
To achieve the best accuracy, have the shunt sensor signal use the whole input range of the SD24. Because the SD24 ADC has an input range of 900 mV at x1 gain, using a x16 gain the input range is

\[
\frac{900}{16} \sqrt{2} = 39.77 \text{ mV}_{\text{RMS}}
\]

With this number, a 2-mΩ shunt resistance suits this input range with the given maximum current (at 16 A, 2 mΩ gives a 32-mV signal amplitude) still leaving about 4 A of head room.

In addition to value, the physical size of the shunt is also an important factor to accuracy—not the size directly, but the heat generated when current flows. A smaller sized shunt heats up more easily due to the limited surface area. If there is significant current to flow through the shunt, have a large enough sized shunt and sufficient ventilation on the PCB to prevent heat being accumulated. In this design, a 2512 size shunt is choose. At 2 mΩ, the power dissipate on the shunt at maximum current is \(16^2 \times 0.5 = 0.128 \text{ W}\), which is about \(\frac{1}{4}\) the rated power of a 2512 size 2-W shunt resistor.

3.3.2 Voltage Divider Circuit

For the voltage sensor circuit, the matter is a little simpler. In this design, the major consideration is that the voltage divisor should be able to prevent arcing between the terminals. To reduce the voltage difference between resistor terminals, this design uses four resistors (instead of two) to form the voltage divider (R1, R13, and R14 are 330 kΩ, and R15 is 1.5 kΩ). Then the voltage across R1, R13, and R14 each take about one-third of the AC voltage. Now at 220-V input, each resistor has a voltage drop of about 75 V. Using the 2512 resistor for R1, R13, and R14 then further separate the live voltage and R15.

The installation of D8 in the voltage sensor circuit is more important than D1 (A, B, C) in the current circuit. The reason is that the resistor ladder on the voltage sensor circuit is more likely to see a voltage surge across R15 high enough to damage the MCU. If R15 is open circuit or in bad contact, causing a higher resistance the voltage across the input of the voltage channel ADC also damages the MCU.
4 Software Description

4.1 Firmware Structure

The firmware is designed to use a layered approach, isolating the user from the details of metrology and the associated computations involved to simplify the programming work.

In user’s view, the firmware is partitioned into three main blocks:

- The application, which contains the function to perform system setup and initialization, main loop, communication protocol and command handling, non-volatile parameters preset, and manipulation.
- The toolkit packaged, which is packed into a library named “emeter-toolkit-i2041.r43”, contains low-level computation routines.
- The metrology computation engine, which is packaged into a library named “emeter-metrology-i2041.r43”, contains the function for ADC setup and initialization, sample-based background processing, reporting cycle-based foreground processing, and result reading API.

NOTE: This package does not include the source code of this library. Contact a local Texas Instruments Sales Team if the source code is needed.

4.2 Metrology Computation Engine

The metrology computation engine performs the actual sampling and computation based on the information collected from the voltage and current ADC channels. The engine acts in a time-critical background process and a less time-critical foreground process.

The background process is triggered by the ADC at the sample rate. This process runs in the interrupt services routine of the ADC and is processed automatically.

The foreground process is triggered by the completion of background process at the reporting and update rate. The background process sets the flag PHASE_STATUS_NEW_LOG in the variable phase_state to indicate that data is ready to be processed by the foreground. The application then needs to monitor this flag to trigger the foreground process by calling to calculate_phase_readings().

In the actual computation, use the following formulas in the metrology computation:

\[
V_{\text{RMS}} = V_{\text{GAIN}} \times \sqrt{\frac{1}{N} \sum_{i=1}^{N} V_{\text{samp}(i)} \times V_{\text{samp}(i)}}
\]

(2)

\[
I_{\text{RMS}} = I_{\text{GAIN}} \times \sqrt{\frac{1}{N} \sum_{i=1}^{N} I_{\text{samp}(i)} \times I_{\text{samp}(i)}}
\]

(3)

\[
P_{\text{active}} = P_{\text{GAIN}} \times \sqrt{\frac{1}{N} \sum_{i=1}^{N} V_{\text{samp}(i)} \times I_{\text{samp}(i)}}
\]

(4)

\[
P_{\text{reactive}} = P_{\text{GAIN}} \times \sqrt{\frac{1}{N} \sum_{i=1}^{N} V_{\text{samp},90(i)} \times I_{\text{samp}(i)}}
\]

(5)

\[
P_{\text{apparent}} = \sqrt{P_{\text{active}}^2 \times P_{\text{reactive}}^2}
\]

(6)

\[
PF = \cos \phi = \frac{P_{\text{active}}}{P_{\text{apparent}}}
\]

(7)
4.2.1 Background Process

The background performs a straightforward, time-critical, sample-based process. The process starts by an interrupting trigger at the sample rate. The background process then

- Captures data from voltage and current ADC channels
- Performs voltage sample processing
- Performs current sample processing
- Performs power processing
- Performs line frequency processing
- Triggers the foreground process

4.2.2 Foreground Process

After reaching the report cycle, the background sets the flag PHASE_STATUS_NEW_LOG. The user main loop checks the status of this flag and calls to the foreground process calculate_phase_readings() to perform the rest of the computation and deliver the measurement readings, including

- Power processing
  1. Calculate active power and reactive power
  2. Calculate the apparent power
- Voltage processing
  1. Calculate the RMS voltage
- Current processing
  1. Calculate the RMS current
- Other processing
  1. Calculate the power factor
  2. Calculate the frequency of the AC line
5 Test Setup

5.1 Apparatus

The following list of instruments help calibrate and test the EVM (See the instrument link in Section 8):

• AC meter test set
• A reference meter that could read AC parameters based on the voltage, current, and phase setting from the AC meter test set

5.2 Setup

![Figure 5. Connection to AC Meter Test Set](image-url)
6  Test Results

Figure 6. Socket A Accuracy Test Result

Figure 7. Socket B Accuracy Test Result

Figure 8. Socket C Accuracy Test Result
7 Design Files

7.1 Schematics

To download the schematics, see the design files at TIDM-3OUTSMTSTRP.

Figure 9. Main System
Figure 10. Protection Circuits
Figure 11. Isolated Serial Board
### 7.2 Bill of Materials

To download the bill of materials (BOM), see the design files at [TIDM-3OUTSMTSTRP](#).

#### Table 1. BOM: Main System

<table>
<thead>
<tr>
<th>ITEM</th>
<th>QTY</th>
<th>REFERENCE</th>
<th>VALUE</th>
<th>PART DESCRIPTION</th>
<th>MANUFACTURER</th>
<th>MANUFACTURER PART NUMBER</th>
<th>PCB FOOTPRINT</th>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>PCB</td>
<td></td>
<td>Printed Circuit Board</td>
<td></td>
<td>XX####</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>C4</td>
<td>470 nF</td>
<td>470 nF</td>
<td>Taiyo Yuden</td>
<td>EMK107F4742A-T</td>
<td>0603</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
<td>C8A, C8B, C8C, C9A, C9B, C9C, C12, C13</td>
<td>47 pF</td>
<td>06035A470JAT2A</td>
<td>AVX Corporation</td>
<td>06035A470JAT2A</td>
<td>0603</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>C10A, C10B, C10C, C14</td>
<td>0.015 µF</td>
<td>GRM188R71C153KA01D</td>
<td>Murata Electronics North America</td>
<td>GRM188R71C153KA01D</td>
<td>0603</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>5</td>
<td>3</td>
<td>C11, C20, C22</td>
<td>0.1 µF</td>
<td>0.1 µF</td>
<td>TDK Corporation</td>
<td>C1005X5R1A104K</td>
<td>0402</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>C19</td>
<td>10 µF</td>
<td>293D106X0010B2TE3</td>
<td>Vishay Sprague</td>
<td>293D106X0010B2TE3</td>
<td>3528-21</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>C21</td>
<td>2200 pF</td>
<td>C0603X222K5RACTU</td>
<td>Kemet</td>
<td>C0603X222K5RACTU</td>
<td>0603</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>8</td>
<td>4</td>
<td>C23, C24, C25, C28</td>
<td>220 µF</td>
<td>293D227X963R2TE3</td>
<td>Vishay Sprague</td>
<td>293D227X963R2TE3</td>
<td>7343-31</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>9</td>
<td>10</td>
<td>D1A, D1B, D1C, D8</td>
<td>SMAJ5.0CA</td>
<td>Littelfuse Inc</td>
<td>SMAJ5.0CA</td>
<td>DSO-C2/X1.8</td>
<td></td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td>D2A, D2B, D2C, D3A, D3B, D3C, D9, D10, D11, D12</td>
<td>V430CH8T</td>
<td>Littelfuse Inc</td>
<td>V430CH8T</td>
<td>V430CH8T</td>
<td></td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>D6</td>
<td>V320SM7</td>
<td>Littelfuse Inc</td>
<td>V320SM7</td>
<td>V320SM7</td>
<td></td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>12</td>
<td>1</td>
<td>D7</td>
<td>7 V</td>
<td>SMBJ7.0A-13-F</td>
<td>Diodes Incorporated</td>
<td>SMBJ7.0A-13-F</td>
<td>SMB</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>13</td>
<td>1</td>
<td>FR</td>
<td>6125FA1A</td>
<td>Cooper Bussmann</td>
<td>6125FA1A</td>
<td>6125FA</td>
<td></td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>14</td>
<td>4</td>
<td>H1, H2, H3, H4</td>
<td>NY PMS 440 0025 PH</td>
<td>NY PMS 440 0025 PH</td>
<td>NY PMS 440 0025 PH</td>
<td>Product Page</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>4</td>
<td>H5, H6, H7, H8</td>
<td>1902C</td>
<td>1902C</td>
<td>Cooper Bussmann</td>
<td>1902C</td>
<td></td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>J5</td>
<td>TSW-102-07-G-D</td>
<td>TE Connectivity</td>
<td>825440-2</td>
<td>TSW-102-07-G-D</td>
<td>Digi-Key Product Page</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>1</td>
<td>J6</td>
<td>Used in BOM report</td>
<td>Sullins Connector Solutions</td>
<td>GRPB061VWWNR-RC</td>
<td>6-pin header (1.27 mm)</td>
<td>Digi-Key Product Page</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>4</td>
<td>J8, J10, J11, J12</td>
<td>1×3</td>
<td>PBC03SAAN</td>
<td>Sullins Connector Solutions</td>
<td>PBC03SAAN</td>
<td>PBC03SAAN</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>19</td>
<td>1</td>
<td>J9</td>
<td>Header 4</td>
<td>TE Connectivity</td>
<td>3-64456-4</td>
<td>HDR1X4</td>
<td>Digi-Key Product Page</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>6</td>
<td>L1A, L1B, L1C, L2A, L2B, L2C</td>
<td>BLM21BD121SN1D</td>
<td>Murata Electronics North America</td>
<td>BLM21BD121SN1D</td>
<td>YW0805</td>
<td>Digi-Key Product Page</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>4</td>
<td>LED1,LED3, LED5,LED7</td>
<td>Used in BOM report</td>
<td>Lite-On Inc</td>
<td>LTW-170TK</td>
<td>0805-LED</td>
<td>Digi-Key Product Page</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>3</td>
<td>LED2, LED4, LED6</td>
<td>Used in BOM report</td>
<td>Lite-On Inc</td>
<td>LTST-C170TBKT</td>
<td>0805-LED</td>
<td>Digi-Key Product Page</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>1</td>
<td>P1</td>
<td>MHDR2X7</td>
<td>TE Connectivity</td>
<td>1-163468-4</td>
<td>2X7BOXHEADER</td>
<td>Digi-Key Product Page</td>
<td></td>
</tr>
</tbody>
</table>
### Table 1. BOM: Main System (continued)

<table>
<thead>
<tr>
<th>ITEM</th>
<th>QTY</th>
<th>REFERENCE</th>
<th>VALUE</th>
<th>PART DESCRIPTION</th>
<th>MANUFACTURER</th>
<th>MANUFACTURER PART NUMBER</th>
<th>PCB FOOTPRINT</th>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>3</td>
<td>R1, R13, R14</td>
<td>330 k</td>
<td>330 k</td>
<td>Vishay Dale</td>
<td>CRCW2512330KF</td>
<td>KEA</td>
<td>R2512</td>
</tr>
<tr>
<td>25</td>
<td>7</td>
<td>R2, R3, R4, R5, R7, R12, R17</td>
<td>390</td>
<td>390</td>
<td>Yageo</td>
<td>RC0603JR-07390RL</td>
<td>0603</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>26</td>
<td>3</td>
<td>R6A, R6B, R6C</td>
<td>ULRB12512R0005FLFSLT</td>
<td>Bourns Inc.</td>
<td>CRF2512-FX-R002ELF</td>
<td>Current Sensing Pad (2512)</td>
<td>Digi-Key Product Page</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>7</td>
<td>R8A, R8B, R8C, R9A, R9B, R9C, R11</td>
<td>1.00 k</td>
<td>1.00 k</td>
<td>Vishay Dale</td>
<td>CRCW06031K00F</td>
<td>KEA</td>
<td>0603</td>
</tr>
<tr>
<td>28</td>
<td>1</td>
<td>R10</td>
<td>100</td>
<td>100</td>
<td>Vishay Dale</td>
<td>CRCW0603100RF</td>
<td>KEA</td>
<td>0603</td>
</tr>
<tr>
<td>29</td>
<td>1</td>
<td>R15</td>
<td>1.50 k</td>
<td>1.50 k</td>
<td>Vishay Dale</td>
<td>CRCW06051K50F</td>
<td>KEA</td>
<td>0805</td>
</tr>
<tr>
<td>30</td>
<td>1</td>
<td>R16</td>
<td>4.7 k</td>
<td>4.7 k</td>
<td>Vishay Dale</td>
<td>CRCW06034K70J</td>
<td>NEA</td>
<td>0603</td>
</tr>
<tr>
<td>31</td>
<td>3</td>
<td>R31, R32, R33</td>
<td>Open</td>
<td>Open</td>
<td>Do not populate</td>
<td></td>
<td>0603</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>1</td>
<td>R34</td>
<td>330</td>
<td>330</td>
<td>Vishay Dale</td>
<td>CRCW0603330RJ</td>
<td>NEA</td>
<td>0603</td>
</tr>
<tr>
<td>33</td>
<td>13</td>
<td>R39, R43, R44, R45, R46, R47, R48, R49, R50, R51, R52, R53, R54</td>
<td>0</td>
<td>0</td>
<td>Vishay Dale</td>
<td>CRCW06030000Z0</td>
<td>EA</td>
<td>0603</td>
</tr>
<tr>
<td>34</td>
<td>2</td>
<td>RELA, RELB</td>
<td>RT314F05</td>
<td>TE Connectivity</td>
<td>RT314F05</td>
<td>TE RELAY TYPE A</td>
<td></td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>35</td>
<td>1</td>
<td>RELC</td>
<td>RZ031A4D005</td>
<td>TE Connectivity</td>
<td>RZ031A4D005</td>
<td>TE RELAY TYPE A</td>
<td></td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>37</td>
<td>1</td>
<td>SOC4</td>
<td>Plug AC Male</td>
<td>Bulgin</td>
<td>PX0580/PC</td>
<td>IEC9.14-2H3</td>
<td>Digi-Key Product Page</td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>4</td>
<td>SOC5, SOCA, SOCB, SOCC</td>
<td>Plug AC Female</td>
<td>Bulgin</td>
<td>PX0675/PC</td>
<td>IEC7-2H3</td>
<td>Digi-Key Product Page</td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>1</td>
<td>U1</td>
<td>MSP430i2040PW</td>
<td>Texas Instruments</td>
<td>MSP430i2040PW</td>
<td>TSSO10x6-G28</td>
<td>TI Product Folder</td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>1</td>
<td>U4</td>
<td>Used in BOM report</td>
<td>CUI Inc</td>
<td>VSK-S2-5U</td>
<td>VSK-S2-5U</td>
<td>Digi-Key Product Page</td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>1</td>
<td>U5</td>
<td>TPS77033DBVT</td>
<td>Texas Instruments</td>
<td>TPS77033DBVT</td>
<td>DBV0008A_N</td>
<td>TI Product Folder</td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>1</td>
<td>U6</td>
<td>ULN2003LVR</td>
<td>Texas Instruments</td>
<td>ULN2003LVR</td>
<td>D0016A_N</td>
<td>TI Product Page</td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>12</td>
<td>U7, U8, U9, U10, U11, U12, U13, U14, U15, U16, U17, U18</td>
<td>TPD1E10B06DPYT</td>
<td>Texas Instruments</td>
<td>TPD1E10B06DPYT</td>
<td>TI</td>
<td>Digi-Key Product Page</td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>3</td>
<td>R56, R57, R58</td>
<td>0</td>
<td>0</td>
<td>Vishay Dale</td>
<td>CRCW08050000Z0</td>
<td>EA</td>
<td>0805</td>
</tr>
<tr>
<td>ITEM</td>
<td>QTY</td>
<td>REFERENCE</td>
<td>VALUE</td>
<td>PART DESCRIPTION</td>
<td>MANUFACTURER</td>
<td>MANUFACTURER PARTNUMBER</td>
<td>PCB FOOTPRINT</td>
<td>NOTE</td>
</tr>
<tr>
<td>------</td>
<td>-----</td>
<td>-----------</td>
<td>-------</td>
<td>------------------</td>
<td>--------------</td>
<td>------------------------</td>
<td>---------------</td>
<td>------</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>C24, C25</td>
<td>0.1 µF, 50 V, ±10%, X7R</td>
<td>CAP, CERM, 0.1 µF, 50 V, ±10%, X7R, 0603</td>
<td>TDK Corporation</td>
<td>C1608X7R1H104K</td>
<td>0603</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>C26, C27</td>
<td>10 µF, 10 V, ±10%, 1.8 Ω, SMD</td>
<td>CAP, TA, 10 µF, 10 V, ±10%, X7R</td>
<td>Kemet</td>
<td>T495A106K010A TE1K8</td>
<td>3216-18</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>D2, D3, D4, D5</td>
<td></td>
<td>Vishay Semiconductor Diodes Division</td>
<td></td>
<td>LL103A</td>
<td>SOD-80</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>J7</td>
<td>Receptacle Assembly, 9 Position, Right Angle</td>
<td></td>
<td>TE Connectivity</td>
<td></td>
<td>DSUB9-F</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>Q1, Q2</td>
<td>Transistor, PNP, 45 V, 0.1 A, SOT-23</td>
<td></td>
<td>Micro Commercial Co</td>
<td>BC857C-7-F</td>
<td>SOT-23</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>6</td>
<td>2</td>
<td>R18, R21</td>
<td>2.2 kΩ</td>
<td>RES, 2.2 kΩ, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ222V</td>
<td>0603</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>R19</td>
<td>Open</td>
<td>RES, Open Ω, x%, xW, [PackageReference]</td>
<td></td>
<td></td>
<td>0603</td>
<td>Open</td>
</tr>
<tr>
<td>8</td>
<td>2</td>
<td>R20, R23</td>
<td>1 kΩ</td>
<td>RES, 1 kΩ, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ102V</td>
<td>0603</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>R22</td>
<td>68 Ω</td>
<td>RES, 68 Ω, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ680V</td>
<td>0603</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td>R24</td>
<td>10 kΩ</td>
<td>RES, 10 kΩ, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ103V</td>
<td>0603</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>R25</td>
<td>1.5 kΩ</td>
<td>RES, 1.5 kΩ, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ152V</td>
<td>0603</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>12</td>
<td>1</td>
<td>R26</td>
<td>220 Ω</td>
<td>RES, 220 Ω, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ221V</td>
<td>0603</td>
<td>Digi-Key Product Page</td>
</tr>
<tr>
<td>13</td>
<td>2</td>
<td>RF1, RF2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>2</td>
<td>U2, U3</td>
<td>Header, SMT 10×2 pin, Shrouded</td>
<td></td>
<td>Samtec</td>
<td>SFM-110-02-SMD-A-K</td>
<td>HEADER_TFM-110-02-SM</td>
<td>Avnet Product Page</td>
</tr>
</tbody>
</table>

Digi-Key Product Page
7.3 PCB Layout

To download the layer plots, see the design files at [TIDM-3OUTSMTSTRP](http://www.ti.com).

7.3.1 Main Board PCB Layout

![Figure 12. Top Layer](image)

![Figure 13. Bottom Layer](image)

![Figure 14. Top Overlay](image)

![Figure 15. Top Paste](image)

![Figure 16. Top Solder](image)

![Figure 17. Bottom Solder](image)
7.3.2 Isolated Board PCB Layout

Figure 22. Top Layer

Figure 23. Bottom Layer
7.4 **Altium Project**
To download the Altium project files, see the design files at [TIDM-3OUTSMTSTRP](#).

7.5 **Gerber Files**
To download the Gerber files, see the design files at [TIDM-3OUTSMTSTRP](#).
7.6 **Assembly Drawings**

To download the assembly files, see the design files at [TIDM-3OUTSMTSTRP](#).

---

**Figure 32. Main Board: Layer 1**

**Figure 33. Main Board: Layer 2**

**Figure 34. Isolated Serial Board: Layer 1**

**Figure 35. Isolated Serial Board: Layer 2**

---

8 **References**

1. KP-P3001-C AC Meter Test Set ([link](#))
2. HC 3100 Reference Meter ([link](#))

9 **About the Author**

**MARS LEUNG** received his bachelor of engineering in Hong Kong Polytechnic University and his master of science at the Chinese University of Hong Kong. He has been field application engineer specialized in MCU application support and development; senior smartcard application engineer specialized in smart card payment system definition and implementation; staff engineer specialized in MCU and new module definition; staff engineer in analog system application specialized in digital system; and video processing of dynamic LED backlight control. He is now staff engineer in Texas Instruments’ smart grid application team specialized in embedded electricity metering application.
Appendix A  Example Application Code

A.1  Introduction

Project structure:

- `emeter-communication.c` – source code for low level UART communication routines including UART port setup, write and read from UART, interrupt services routine for byte-wise send and receive
- `emeter-dlt645.c` – source code for the polling mode protocol implementation
- `emeter-main.c` – source code for system initialization, main loop, callback functions implementation and interrupt vector placement
- `emeter-meterology-i2041.r43` – embedded metering library object code
- `emeter-setup.c` – source code for low level system initialization
- `emeter-template.h` – source code for configuration
- `metrology-calibration-default.c` – source code to put the user defined default calibration parameter into a proper data structure (should not modify this file)
- `metrology-calibration-template.h` – source code of user defined default calibration parameter
A.2 Preparing the Application Code to Run

1. Launch the IAR5.5 Embedded Workbench IDE and click on File → Open → Workspace.
2. Select “emeters.eww” when prompted to open Workspace.

3. Select the emeter-app-i2041 project tab at the bottom of the Workspace window.
4. Check project options by right clicking project name and select Options… from the pop-up menu (see Figure 37).

![Figure 37. Project Tab](image)

5. When the options appear, select C/C++ Compiler on the left-hand column. Then select the Optimizations tab on the right-hand side and check the optimization settings as shown in Figure 38.

![Figure 38. Optimization Options](image)
6. Select *FET Debugger* on the left-hand column, then select the *Setup* tab. The EVM uses Spy-Bi-Wire for its code downloading and debugging. Check to make sure the options are as shown in Figure 39.

   ![Figure 39. Debugger Options](image)

7. Select the *Download* tab. Under *Flash erase*, do not choose *Erase main memory and Information memory*; this option erases both sets of data and cannot be recovered. Instead, choose *Erase main memory* as the download option to preserve these factory parameters: system clock calibration, ADC calibration, and internal reference calibration (see Figure 40). However, metrology calibration stored in the main memory, such as VGAIN, IGAIN, PGAIN, and so on, are always erased after downloading.

   ![Figure 40. Download Options](image)

8. Click *OK* after all of the changes are made.
9. Rebuild the project by right clicking on the project and select Rebuild All from the pop-up menu (see Figure 41). Three warnings will be reported during rebuilding (see Figure 42), which are safe to ignore. To open the project workspace and modify, compile, and download the code, the user must have IAR Embedded Workbench 5.5 installed with a valid license. If a valid license is not available, the user can still download the object code. See Section A.3 for downloading procedures.
10. Make sure the jumper on J8 is short properly. Connect the 14-pin connector P1 to MSP-FET430UIF by a flat cable as shown in Figure 43.

**CAUTION**

The debugging interface is not isolated. Make sure to proper isolate between the EVM and the PC used for debugging with AC or DC high voltage connected.

**NOTE:** Connection to debugging interface is optional for the operation of the EVM. The EVM can operate without a debugger connected.

11. Click the *Download and Debug* button to download and debug (see Figure 44).

---

**Figure 43. Connecting EVM and FET**

**Figure 44. Code Downloading**
12. After successfully completing the download, Figure 45 will appear. Click Go to run the application.

Figure 45. Debugger Screen

Figure 46. EVM Running with Debugger
A.3 Downloading Without an IAR License

If a valid IAR Embedded Workbench 5.5 license is not available, download the executable code to the board with the following steps using the installed IAR Embedded Workbench 5.5.

1. Open the project workspace as described in Section A.2, Steps 1 through 6. Connect the board to the MSP-FET430UIF as described in Step 10 in Section A.2.
2. Select Project→Download→Download File… from the menu (see Figure 47).
3. When prompted to select the file, go to the folder [Submeter i2040 4k_3.SOCK_AUTO_OSR_IAR5.5]\emeter-app\emeter-app-i2041\Debug\Exe and select the file named “emeter-app-i2041.d43” (Figure 48).
4. The executable code will then download to the board.

Figure 47. Download Executable File

Figure 48. Select File to Download
Appendix B  EVM Operation

B.1  Download Application Code
Download application to the board by using the IAR compiler as described in Appendix A.

B.2  Setup the EVM Hardware

**CAUTION**
Do not supply power to the EVM until the hardware and software setup is completed.

1. Install jumper to J5 as shown (Figure 49).

![Figure 49. EVM J5 Jumper Setting](image)

2. Install jumpers to J10, J11, and J12 as shown in Figure 50.

![Figure 50. J10, J11, J12 Jumper Setting](image)
3. Install the isolated serial communication module as shown in Figure 51 and connect the EVM to a serial port on the PC.

![Figure 51. Serial Communication Module Installation](image)

**B.3 Install and Run PC Software**

**B.3.1 Installing PC Software**

Unzip the file named "calibrator-runtime.zip" into any folder. A folder named "calibrator-runtime" containing the necessary files to run the software tool will be in that folder. The file named "calibrator-20121120.exe" is the executable file of the software tool. The file named "calibrator-config.xml" contains the setup information for the software tool. Users must make a few edits to this XML file before calibrator-20121120.exe can launch.

**B.3.2 Configuring PC Software**

Follow these steps to setup the XML file for calibrator-20121120.exe to run properly:

1. Right click the **My Computer** icon and select **Properties** in the pop-up menu.
2. Select **Device Manager** to go to the **Device Manager** window and check the COM port number of the serial port that connects the PC and the EVM (Figure 52).

![Figure 52. Device Manager Window](image)
3. Open “calibration-config.xml” in the folder “calibrator-runtime” with a text editor or XML editor. Go to the line highlighted in Figure 53, put in the COM port number in, and save the file.

![Figure 53. Editing “calibration-config.xml”](image)

**B.4 Start Using the EVM**

To run the readied EVM, launch the software “calibrator-20121120.exe” in the folder “calibration-runtime” to start communicating with the EVM. A window as shown in Figure 54 appears. As defined in the XML file “calibration-config.xml”, meter position 1 is assigned the serial port to communicate with the EVM. The **Comms** indicator will turn green if communication to EVM from PC is established, and it will flash between read and green when the communication takes place.

![Figure 54. Calibrator Software Startup Window](image)
Click on the Comms indicator the Meter status window as shown in Figure 55.

![Figure 55. Meter Status Window](image)

This window shows the current reading of the meter. The background of a reading box is gray if the EVM does not support that particular reading. The box turns red if the reading from EVM to that box has a large variance, yellow if the reading from EVM has a fairly low variance, and green if the reading has a low variance. Note that the software on PC reads the EVM every second and averages the data read, meaning the update rate is slower than the update rate of the EVM.

At the bottom of this window, there are four buttons.

- The Meter consumption button brings up the Meter consumption window. This window gives no useful information because the EVM does not support this feature.
• The **Meter calibration factors** button brings up the **Meter calibration factors** window, which shows the current calibration factor values (see Figure 56).

![Figure 56. Meter Calibration Factor Window](image)

• The **Meter features** button brings up the **Meter features** window. This window reports the support feature of the EVM (see Figure 57).

![Figure 57. Meter Features Window](image)
The Manual cal button brings up the Manual cal window (Figure 58). In this window, adjust the calibration factor values if needed by entering the percentage error of the reading from the EVM and compare to the reading from the reference meter. The technique and procedure of performing calibration will be discussed in further details in Appendix C.

![Figure 58. Meter Error Window](image)

To modify the calibration factor, enter the correction in the percentage error. The percentage error is calculated as follows:

\[
\text{%Error} = \frac{\text{EVM Reading} - \text{Reference Meter Reading}}{\text{Reference Meter Reading}} \times 100\%
\]

Put the percentage error into its corresponding box in Meter calibration window. Click Update meter to calculate and write the updated calibration values to the EVM. The corresponding values will be reflected in the Meter calibration factor window (Figure 56).

### B.5 Known Issues

The calibrator software is legacy software that operates with utility meters that have not customized completely for embedded metering. The following is a list of known issues with the existing software that will be fixed in the next version of calibrator software customized for embedded metering.

- Voltage AC offset values cannot be written with the calibrator software. The value put into the Voltage AC offset box is actually written to the Current AC offset instead. The value put into the Current AC offset box has no effect.

- The aggregate current in Meter status windows always show 10.0000 A.
Appendix C  EVM Calibration

C.1  Introduction
The EVM is programmed with calibration values that allow the EVM to give roughly accurate readings; however, the EVM has not been calibrated while shipped. To maximize accuracy and to compensate component and manufacturing tolerance, the EVM must go through a calibration process. This chapter will discuss the techniques, procedures, and steps of calibration.

C.2  Calibration Techniques
The calibration requires to use the instrument listed in Section 5.1 and connected properly as in Section 5.2. Calibration should be done for each socket.

This design requires a two-point calibration. VGAIN, IGAIN, PGAIN, VDC_OFFSET, and IDC_OFFSET are parameters that will be calibrated during the process; an estimated value is put into the memory during the design and characterization to help to speed up calibration.

VAC_OFFSET, IAC_OFFSET, PHASE_CORRECT are parameters that may not need calibration, but a characterization would be sufficient for embedded metering application except for a high accuracy of <0.1%.

NOTE: The calibration values are written in one flash page in the EVM, so when a new value needs to be written the whole page is erased. The provided GUI will do the read, modify, and write operations automatically. When using a user calibration facility, read the complete set of calibration values, back them up, update the modified field, and write the complete set back to the EVM.

C.3  Calibration Procedures

C.3.1  Calibration of AC Parameters
Use the following steps to calibrate the AC parameters.

Calibrating VGAIN

1. Set \( V_{IN} \) to line voltage.
2. Calculate the value for VGAIN with the formula
   \[
   VGAIN_{n+1} = \frac{V_{REF}}{V_{UUT}} \times VGAIN_n
   \]
   where
   - \( VGAIN_{n+1} \) is the new voltage calibration factor
   - \( VGAIN_n \) is the original voltage calibration factor
   - \( V_{REF} \) is the reference meter voltage reading at the voltage set for VGAIN calibration
   - \( V_{UUT} \) is the unit under test voltage reading at the voltage set for VGAIN calibration
   or, if percentage error is used (as with the provided calibration software),
   \[
   \%Error = \frac{V_{UUT} - V_{REF}}{V_{REF}} \times 100\%
   \]
3. Write and apply the calibrated VGAIN.
Calibrating IGAIN

1. Set to calibration current (for example, 5 A).
2. Calculate IGAIN value with the formula

\[
IGAIN_{n+1} = \frac{I_{\text{REF}}}{I_{\text{UUT}}} \times IGAIN_n
\]

where

- \( IGAIN_{n+1} \) is the new current calibration factor
- \( IGAIN_n \) is the original current calibration factor
- \( I_{\text{REF}} \) is the reference meter current reading at the current set for IGAIN calibration
- \( I_{\text{UUT}} \) is the unit under test current reading at the current set for IGAIN calibration

or, if percentage error is used (as with the provided calibration software),

\[
\%\text{Error} = \frac{I_{\text{UUT}} - I_{\text{REF}}}{I_{\text{REF}}} \times 100\%
\]

3. Write and apply the calibrated IGAIN.

Calibrating PGAIN

1. Set to calibration current (for example, 5 A) and power factor = 1.
2. Calculate PGAIN gain with the formula

\[
PGAIN_{n+1} = \frac{P_{\text{REF}}}{P_{\text{UUT}}} \times PGAIN_n
\]

where

- \( PGAIN_{n+1} \) is the new power calibration factor
- \( PGAIN_n \) is the original power calibration factor
- \( P_{\text{REF}} \) is the reference meter power reading at the power set for PGAIN calibration
- \( P_{\text{UUT}} \) is the unit under test power reading at the power set for PGAIN calibration

or, if percentage error is used (as with the provided calibration software),

\[
\%\text{Error} = \frac{P_{\text{UUT}} - P_{\text{REF}}}{P_{\text{REF}}} \times 100\%
\]

3. Write and apply the calibrated PGAIN.
C.3.2 Calibration of Current AC Offset

The current AC offset is the result of noise pickup, and the offset generated on the shunt resistor circuit causes an illusion of having a finite current flowing when there is actually not current flowing through the shunt. Although this noise current does not affect the power reading’s accuracy, this illusion contributes to the current reading and its accuracy, especially when the current is small. To offset this miscalculation, the EVM firmware has the mechanism to remove this from the current reading. The steps to calibrate this current offset are as follows:

1. Apply nominal voltage to make sure the EVM operates.
2. Remove all loading from the EVM.
3. Take multiple current readings (for example, 100) and take an average as \( I_{\text{NOISE}} \) (in A).
4. Calculate the current AC offset value with the equation

\[
I_{\text{AC OFFSET}} = \text{int}\left( I_{\text{NOISE}} \left( \frac{1024 \times 10^6}{IGAIN} \right)^2 \right)
\]  

5. Write and apply the calibrated \( I_{\text{AC OFFSET}} \).

NOTE: This is a big number even in the case of a few mA of noise.

C.3.3 Calibration of Voltage AC Offset

In most cases, the voltage AC offset rarely affects the voltage reading and does not require calibration.

C.3.4 Calibration of Phase Correction

1. Set the test set to generate rated voltage and set to calibration current (for example, 5A).
2. Make sure calibrations are complete for PGAIN (at PF = 1).
3. Set the test set to output at power factor 0.5 (+ or – is not important at this point).
4. Note the error.
5. Switch the test set to output at power factor 0.5 in the other direction to Step 3.
6. Note the error.
7. At this point, both errors should be approximately the same deviation but a different direction from the calibrated power error at PF = 1
   - For example, at PF = 1, the calibrated error is 0.1%. If at PF = 0.5, the error reads about 0.5%. Then at PF = –0.5, the error should read about –0.3%.
8. Adjust the phase correction with time deviation from the current phase correction such that the power errors at PF = ±0.5 are minimized.
   - For example, if the current phase correction is 13 μs and 11 μs is desired, enter –2 into the phase correction box of the Manual calibration window.
9. Repeat for all the sockets.
Appendix D  EVM Specification

- Voltage operating range (with supplied power supply) : 85 to 265-V AC
- Sample rate: 4000 Hz
- Sampling bit depth: 24 bits
- Polling report supported
- Update rate: Eight AC cycles
- UART communication data rate: 9600 bps
- Measurements: RMS voltage, RMS current, active power, reactive power, apparent power, power factor, and line frequency
  - Measurement voltage range: 0 to 265-V$_{R MS}$ AC
  - Measurement current range: 0 to 15-A$_{R MS}$ AC
- Voltage resolution: 1 mV
- Current resolution: 1 µA
- Active Power resolution: 1 mW
- Reactive/Apparent Power resolution: 1 mW
- Power factor resolution: 0.001
- Frequency resolution: 0.01 Hz
Appendix E  Running on MSP430i2040 and MSP430i2041

The example IAR project has been configured for MSP430i2041. To run on MSP430i2040, follow these steps once:

1. Open the workspace. After launching IAR 5.5, select *File→Open→Workspace.*

![Figure 59. IAR 5.5 Launch Window](image-url)
When prompted to open the project, select `emeters.eww` from the project directory of the example code.

2. Set the option. Right click on the project `emeter-app-i2041` and select `Options...`
In the Options window, click on General Options on the left-hand column and then select the Target tab. Then, in the Device section, click on the right-hand side button of the entry box and select MSP430xxxx Family → MSP430I2040.

**Figure 62. Options Window**

Click on Linker in the left-hand column and select the Config tab. Then click on the right-hand button in the Linker configuration file box.

**Figure 63. Config Tab**
Select *lnk430i2040_temp.xcl* when prompted and click *Open*.

![Figure 64. Selecting Default XCL File](image)

When brought back to the *Options* window, click *OK*.

![Figure 65. Finishing the Setting Changes](image)
When brought back to the main screen, select **File→Save** to save the setting.

The project is now set for run on MSP430i2040. To have the project run back on MSP430i2041, follow the same steps except select MSP430Ixxxx Family→MSP430I2041 in the **Options** window and select **lnk430i2041_temp.xcl** when prompted in the **Linker configuration file** box.
IMPORTANT NOTICE FOR TI REFERENCE DESIGNS

Texas Instruments Incorporated ("TI") reference designs are solely intended to assist designers ("Buyers") who are developing systems that incorporate TI semiconductor products (also referred to herein as "components"). Buyer understands and agrees that Buyer remains responsible for using its independent evaluation, analysis and judgment in designing Buyer's systems and products.

TI reference designs have been created using standard laboratory conditions and engineering practices. **TI has not conducted any testing other than that specifically described in the published documentation for a particular reference design.** TI may make corrections, enhancements, improvements and other changes to its reference designs.

Buyers are authorized to use TI reference designs with the TI component(s) identified in each particular reference design and to modify the reference design in the development of their end products. HOWEVER, NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY THIRD PARTY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT, IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

TI REFERENCE DESIGNS ARE PROVIDED "AS IS". TI MAKES NO WARRANTIES OR REPRESENTATIONS WITH REGARD TO THE REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, EXPRESS, IMPLIED OR STATUTORY, INCLUDING ACCURACY OR COMPLETENESS. TI DISCLAIMS ANY WARRANTY OF TITLE AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, QUIET ENJOYMENT, QUIET POSSESSION, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS WITH REGARD TO TI REFERENCE DESIGNS OR USE THEREOF. TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY BUYERS AGAINST ANY THIRD PARTY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON A COMBINATION OF COMPONENTS PROVIDED IN A TI REFERENCE DESIGN. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES, HOWEVER CAUSED, ON ANY THEORY OF LIABILITY AND WHETHER OR NOT TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, ARISING IN ANY WAY OUT OF TI REFERENCE DESIGNS OR BUYER'S USE OF TI REFERENCE DESIGNS.

TI reserves the right to make corrections, enhancements, improvements and other changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and complete. All semiconductor products are sold subject to TI's terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI's terms and conditions of sale of semiconductor products. Testing and other quality control techniques for TI components are used to the extent TI deems necessary to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily performed.

TI assumes no liability for applications assistance or the design of Buyers' products. Buyers are responsible for their products and applications using TI components. To minimize the risks associated with Buyers' products and applications, Buyers should provide adequate design and operating safeguards.

Reproduction of significant portions of TI information in TI data books, data sheets or reference designs is permissible only if reproduction is without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional restrictions.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards that anticipate dangerous failures, monitor failures and their consequences, lessen the likelihood of dangerous failures and take appropriate remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use of any TI components in Buyer's safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI's goal is to help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and requirements. Nonetheless, such components are subject to these terms.

No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties have executed an agreement specifically governing such use.

Only those TI components that have specifically designated as military grade or "enhanced plastic" are designed and intended for use in military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components that have not been so designated is solely at Buyer's risk, and Buyer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2014, Texas Instruments Incorporated